
 1 

 

For further resources and updates visit http://kingston-upon-thames.e-voice.org.uk/   1 

Voice Advanced for  

Topic             Page number 

Applications - enabling and re-naming      2 

What are includelets?          3 

Structuring your website using columns and includelets  4 

Changing column layouts and adding includelets   5 

Removing and moving includelets       6 

How to embed content from external websites    8 

Understanding relationships: applications and includelets  9 

Filtered item list: structuring using grids and lists    10 

Item list: creating grids and lists of images or random pages 17 

Adding a You Tube or Vimeo video       19      

Permissions, members and administrators     20 

Participant course notes 



 2 

 

For further resources and updates visit http://kingston-upon-thames.e-voice.org.uk/  

Applications: enabling and renaming 

1. Click Enable to add a new application 

2. Choose a URL for the application  

3. Rename - changes the name in the Applications list and in 

the Navigation bar (that your visitors will see) 

4. Show in Navigation - this is ticked by default. Un-tick if you do 

not want it to show in your top level navigation 

5. Click Manage this Application to start adding your 

information 

 

If you don’t include in the 

navigation but want to include it 

on a 2nd level navigation e.g. 

under about us you’ll need to 

create a re-direct page first, 

then copy and paste the live 

URL of the application into the 

field provided. 

Note: You can also click on Disable to 

remove the application from your website if 

you no longer need it 

These pre-configured applications allow you to organise 

your information effectively and deliver it to your user in a 

way that increases sharing and interactivity. You will find 

them in Content Management. 
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What are includelets? 

Includelets help you to:  

 Add pieces of information to your page to make it more interesting e.g. images  

 Bring information into your site from another organisation’s website (embedding 

content e.g. widgets). 

 Display information that updates automatically from another part of your site (some 

are directly related to applications) 

 Set information to appear on all pages within a section or across the whole site e.g. 

blog posts 

 

The includelets you are most likely to use are: 

Custom– a blank box that has the same editing options as a webpage e.g. add 

photos, text and more 

Filtered item list – customised display of content from other pages, in grids or lists 

 

The ‘Content’ includelet is your main webpage - so don’t delete it! You 

can add other includelets above and below the content item to structure your 

webpages effectively. 

‘Includelets’ are primarily used to automatically generate dynamic snippets of 

information to display on your webpage. 
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Structuring your website using columns and includelets 

Column layout and includelet placement offer a way of structuring your website 

1. Choose a page to edit 

2. Move from the Edit tab to the Layout Tab 

This will show you a diagram of the structure of your page. You can choose a different layout for each page.  

 

Content item– the main section of your page. If you never added 

anything into the other columns and only used the central Content 

column everything on your site would be full width of the page. (But 

you edit the text in this box in the Edit tab of your webpage!) 

Right or Left – if you have a page layout with more than one column 

Relations - you can add a related image or related webpages - 

enables you to display multiple pieces of related content on another 

webpage e.g. in a grid of images with teaser text 

Scratch – doesn’t display on your site but saves it in case you want to 

use it again 

Trash – area to move any includelets that you don’t want and won’t 

need again. These are removed permanently  
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Changing layout and adding includelets 

Changing column layouts and adding includelets 

1. Click on the red link “Create a new revision to make changes” 

 

 

 

2. Now the includelets will turn white and be editable  

3. Double click on the includelet to open it for editing 

4. Click on ‘Add includelet’ to start adding dynamic information to your website 

 

Croydon Mencap webpage structures - which column template should I choose? 

Whilst the website may show a five column area ins some cases, most of the time you will structure 

your website using Filtered Item List and Item List includelets: 

To change the column template: 

At the bottom of the layout tab, click on ‘Change’ under Current template 
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Removing and moving includelets 

The following options are available to you: 

 Move it to Scratch (save) 

 Move it to Trash (permanently delete) 

 Move it to a different column 

 Move it up or down the webpage 

To use the options above: 

1. Click to create a new revision 

2. Click and hold on the includelet 

3. Drag it to the right place 

4. Release when a thick red line appears 

5. Publish under the Publishing Tab 

Things to remember 

You must Publish it in the Publishing tab (or in the Edit tab): saving will not make it live on the site as it is just a component 

of a page 

Never remove the Content Item from the Content Column as this is the main body of your page (what you see in the Edit 

tab) 

Removing and moving includelets 
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Embedding content into webpages 

Websites such as Flickr, Facebook, Twitter, Google maps, 

Google calendars, You Tube, AudioBoo and many more 

allow you to embed content from their website onto your 

webpage. 

Some require you to set up a free account so that you can 

upload your content on their website first. 

They then make available some code for you to copy and 

paste (embed) into your webpage (as html) 

Many allow you to customise or select how this content 

displays e.g. box size and border colour 

 

Embed content in your Voice website 

The Custom includelet is a useful includelet. In addition to adding text and images, it allows you to display a wide variety 

of information pulled from external websites (embedding the content using html codes that the external site can give 

you). The next page will show you how to do this. 

Embedding content from external websites 
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Embedding content using a Custom Includelet 

1. Click Add Includelet 

2. Select Custom  

3. Open another tab and enter the URL of the website 

that you want to get information form e.g. You 

Tube, Google or Issuu  

4. Copy the code the website gives you 

5. In your custom includelet click on HTML 

6. This will open a new screen 

7. Paste your code here 

8. Click on Update 

You can also use the embed button < > 

Embedding content using a custom includelet 
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Example: Adding a Community Calendar includelet 

You must have the calendar application enabled on your website and 

have added and published at least one event to do this: 

1. Click Add Includelet 

2. Community Calendar  

3. Add the maximum number events you want to display 

4. Give a time period / Days to display  

5. How much of description to show 

6. Inherit to subpages – No to just show on this page, Top or Bottom to 

place it on every page beneath this one in the Site Map 

7. Save changes 

8. Go to Publish Tab and click Publish to make live 

At Croydon Mencap we do not use the Community Calendar or News 

includet 

Some includelets in Voice display information that you have added to applications that are enabled on your website. 

The Community Calendar includelet is linked to the Calendar application. The Latest News includelet is related to the 

News Story page type (not an application).  

Understanding relationships: applications and includelets 
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The Filtered Item List enables you to display 

information from multiple webpages in a grid or a list 

on another webpage. This makes use of things like 

related images, titles and teaser descriptions from 

each page. 

When the visitor clicks on an image or the title e.g. 

Monday Night Social Club, they will be taken straight 

to that page 

Structuring using Filtered item list includelets 

 

Leave blank if you don’t want a title displaying on the page e.g. the one above does not use  title because there 

is some text above that has the title Active Lives 

Ignore this 

Display mode chooses whether the 

box has a coloured background. Use 

the Panel colour drop down to 

choose from a range of Croydon 

Mencap colours. 

In-line has a white background and 

copies the styling of a normal 

webpage. 

Your display mode will be mostly in-

line. Use panel sparingly. 
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List mode decides how the box will display the items 

The Filtered item list includelet 

This shows List mode ‘Separate Wells’. 

This is Grid 3 Wide (Mobile 1) 

Mobile 1 means that when someone is looking at your webpage on a phone or small tablet, one item will fill the full width of the screen e.g. 

Monday Night Social Club. The other items will drop down underneath. They would scroll down to see The Saturday Club and then Healthy 

Lives.  

This shows List mode ‘Grid 1 Wide’ for 

Clubs @ Leslie Park on the Clubs and 

activities page 
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The Filtered item list includelet 

Choose what Content type of pages you want to show content from e.g. 

webpage, news story. You can leave as Any type under Content type 

Children means any page that exists under the Parent page 

You can also choose a specific tag, Keywords, e.g. ‘Vacancies’.  

Croydon Mencap’s Filtered Item Lists do not need keywords for most 

filtered item lists. They are used for Team pages. Insert these in your style 

guide. 

Keywords are case sensitive.  

To use Related, you must first go the Relations tabs of the pages to choose 

which other pages they are related to. 

When you Select item, all other pages that you wish to display must sit 

underneath it in your site map. For example if you want to show a grid of 

latest stories and news you must choose Stories and news as the Parent 

item. 

If pages are in completely different sections of the site then hyou will 

probably need your home page as the Parent item. 

Ignore this 

Choose what type of pages you want to show content from e.g. 

webpage, news story. You can leave as Any type under Content type 
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Search keywords. As it says here Items (webpages) which have any of the 

keywords you write in this box will be filtered to show in the grid or list. You must 

separate them by commas.  

One keyword can consist multiple words e.g. Portland House 

A note on Search keywords 

If you have chosen Keywords, scroll down to complete the Search keywords box 

To filter webpages by keywords, they must exist on those pages.  

Keywords are entered on the individual webpages at the bottom of the Edit tab. 

Keywords are case sensitive. In this example, Alan, Abigail and Carole all have an 

individual staff page. On each page is the Keyword: Portland House 
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The Filtered item list includelet 

You have some Extra display options available.  

You must tick Related image if you want your grid or list 

of webpages to show an image. The images must be 

added to the individual webpages in the Relations tab. 

Set a Publish start date for your grid/list to display - useful if you had a long list of news 

stories and you only wanted to show the last three months worth of pages. 

Item display mode: this is about how the text displays with or without an image.  

Short title:   displays the menu title 

Full title:    displays the long title at the top of your webpage 

Teaser:    displays the extra text description that is not normally visible on the webpage 

    itself along with the full title 

Related image: displays only an image (no text) 

Full:     displays everything on each individual page in a list or grid of pages. Only  

    use this if the information on the individual pages is short. 
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The Filtered item list includelet 

Related image mode: you have a choice of displaying related images at different sizes.  

Most of Croydon Mencap’s filtered item lists show the full image or medium sized. 

Related image aspect ratio: you have a choice of what shape your images will be 

displayed as. 

Most of Croydon Mencap’s filtered item lists use 16x9 (widescreen). 

Do not use Natural (as source). This could lead to inconsistencies on your website if photos 

are all different shapes and sizes.   

If you have used 16x9 and one of the images is not displaying correctly or filling the space it 

is likely that the image is too small (not of a high enough quality). 

Sort order: decides the chronology or order of the webpages you are displaying 

Fixed order: the order the webpages appear in the navigation 

Title:   alphabetical 

Newest first:  the most recently published item is displayed first (e.g. Stories and news) 

Oldest first:  the least recently published item is displayed first (not used anywhere) 

Random:  it doesn’t matter about the order 
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The Filtered item list includelet 

Paginate: allows a visitor to sort alphabetically or by date if it displays lot of 

pages e.g. news items here https://superhighways.org.uk/latest/  

Present links: Only useful if there are lots of webpages included! 

Limit: set the limit if you have a grids that you want to keep nicely displayed 

e.g. set it at 3 for a grid of three or 6 for a grid of six.  

Tree depth: set this to 1 in most cases. This prevents stray pages in the site 

map below your chosen pages from displaying. E.g. On the support page 

you wouldn’t want a page that had been 

created underneath Adults with a learning 

disability to appear in this grid. Ignore this 

Inherit this includelet to subpages:  

Only if you want it to be duplicated on the 

pages that sit underneath the Parent item 

Don’t forget to Save changes. You can preview or go to the Edit tab or 

Publishing tab to publish on your live site 

https://superhighways.org.uk/latest/
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Item List includelet 

The Item List includelet helps you to create a grid or list of different types of content e.g. text and images that are not 

linked to pages.  

You can also select individual webpages that are not children, related or filtered by keywords. For example, if you wanted 

to have a grid of three pages from anywhere on your site you may choose to use the Item List rather than a keyword.  

Many of the choices available are the same as a Filtered Item List. 

Title: Complete if you want a normal sized title 

Graphic: You probably won’t need this. It may be useful if you were just 

showing one item. 
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Item List includelet for text and images 

How to create a  grid or list of text and / or images only: 

List mode: choose how the items will display, depending on the 

number of items to display and the amount of information e.g. text 

Add other: add a graphic and / or text. You can add multiple items and give it a title and teaser 

If you are adding graphics you must click on Select item  

Then Add Item to save whatever information you have added 

You can then move items up and down to put them in the correct 

order. Here we have added two random images side by side 

Finally, you can make some other choices about styling before 

Saving Changes 
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YouTube  or Vimeo includelet 

Display mode: choose a Panel to surround your video with a coloured 

box. You can also choose a Panel colour 

Use Inline to have a clear 

(white) background so that it 

looks like it’s just on the white 

webpage. 

Title:   leave blank for no large title above your video 

Description:  if you want to put some text before the video 

Finally, you can make some other choices about the Aspect Ratio 

before Saving Changes. 

YouTube video id or URL: Copy and 

paste the YouTube link into the box. You 

do not need an embed code. Just the 

link e.g. https://youtu.be/HMhOaQnaF48  
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Permissions 

Permissions can be set at various levels: 

 Whole site – set under Users and Permissions Tab 

 Top Level Pages and Folders – set under Permissions Tab when editing that page 

 Applications – in the Applications Admin area 

 

Levels of Permission: 

 Admin – full rights 

 Edit – can add information to page and applications 

 Read – can see the content, but cannot contribute 

 

Users 

 Registered Users  - anyone registered with the Voice system (not specifically your site) 

 The Public – anyone visiting the site 

 Administrators – full access to the whole system, including making others administrators 

 Members – people who register with your site to be notified of updates or contribute to 

discussions 
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 Private Area Members – people specifically invited to have access to the Private Area 

 Named People – members of your site with permissions for specific pages/applications 

 

Users—Members 

 Go to Users & Permissions – Members 

 Members awaiting approval will be on left 

 You can Approve, Deny or just ignore these requests 

 People may register for updates from certain applications e.g. Noticeboard, FAQ 

 They may just be interested in your organisation 

 They may want to take part in polls, surveys and discussions 

 Approving them won’t automatically give them any special privileges unless you’ve set this up 

 Recommend approving all members as you can email them directly from the system under Users &  Permissions  

 Set it to automatically email new members – Welcome Email 

 Email Members or Administrators e.g. with updates on your work 

 You can invite people to join by entering their email address 

 If they are already registered with Voice they will appear in the list of members automatically, otherwise they will 

receive an email asking them to register 

Members 
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Making someone an administrator of your website 

You can make any member an administrator by clicking Make Administrator button by their 

name 

 

 

 

 

 

 

 

 

 

 

You can revoke Administrator rights and remove them entirely – this is why it is very important not 

to share one username/password between many people.  

Every member or administrator should have their own password. 

Administrators 

Confidential 


